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Chapter 1 - Introduction 

About Navicat Report Viewer 

Navicat Report Viewer is an easy-to-use tool. With its friendly Graphical User Interface (GUI), Navicat Report Viewer 

allows you to navigate reports designed by Navicat's Report Building Tool. You can access reports located at local or 

remote MySQL, Oracle, PostgreSQL, SQLite, SQL Server and MariaDB, no matter the server is running on a Linux, 

Unix, macOS or Windows platform. It also can connect cloud databases such as Amazon Redshift, Amazon RDS, 

Alibaba Cloud. 

Navicat Report Viewer allows you to share reports with someone who does not have Navicat running on his computer 

but has Navicat Report Viewer installed. It highly increases the flexibility and convenience for viewing reports. Files 

in .raf & .rtm formats can be viewed. It also gives you the ability to print reports in pdf, html & archive formats. 

Navicat Report Viewer is available on Windows platform only. For details, visit our website: https://www.navicat.com 

System Requirements 

Windows 

 Microsoft Windows Vista, Windows 7, Windows 8, Windows 8.1, Windows 10, Server 2008, Server 2012, 

Server 2016 

Supported On-Premises Databases 

 MySQL 3.23 or later, Drizzle, OurDelta, Percona Server 

 PostgreSQL 7.3 or later 

 Oracle 8i or later 

 SQLite 2 and 3 

 SQL Server 2000 or later 

 MariaDB 5.1 or later 

Supported Cloud Databases 

Amazon AWS 

 Amazon Redshift 

 Amazon Aurora for MySQL 

 Amazon Aurora for PostgreSQL 

 Amazon RDS for MySQL 

https://www.navicat.com/
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 Amazon RDS for PostgreSQL 

 Amazon RDS for Oracle 

 Amazon RDS for SQL Server 

 Amazon RDS for MariaDB 

Google Cloud 

 Google Cloud SQL for MySQL 

 Google Cloud SQL for PostgreSQL 

Oracle Cloud 

 Oracle Database Cloud Service 

 Oracle MySQL Cloud Service 

Microsoft Azure 

 Microsoft Azure SQL Database 

 Microsoft Azure Database for MySQL 

 Microsoft Azure Database for PostgreSQL 

Alibaba Cloud 

 Alibaba Cloud ApsaraDB for RDS (MySQL) 

 Alibaba Cloud ApsaraDB for RDS (SQL Server) 

 Alibaba Cloud ApsaraDB for RDS (PostgreSQL) 

Tencent Cloud 

 TencentDB for MySQL 

 TencentDB for SQL Server 

 TencentDB for PostgreSQL 

 TencentDB for MariaDB 

Huawei Cloud 

 Huawei Cloud RDS for MySQL 

 Huawei Cloud RDS for PostgreSQL 
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 Huawei Cloud RDS for SQL Server 

Installation 

We strongly suggest that you shut down any opened applications. This will help ensure a smooth installation. 

Note: For user who has been trying our unregistered version, just simply key in the Registration Key (16 digit) on the 

pop up Registration screen. 

Installation for Download Version 

1. Download Navicat Report Viewer Windows version. 

2. Open the .exe file. 

3. Click Next at the Welcome Screen. 

4. Read the License Agreement. Accept it and click Next. 

5. Accept the location of the program icons by clicking Next. If you wish to change the destination of the folder, 

click Browse. 

6. Follow the remaining steps. 

7. After installed, key in the Registration Key (16 digit) on the pop-up Registration screen and click Activate to 

online activate the key. 

Installation for CD Version 

1. Load the Navicat Report Viewer CD Installation disk into the CD-ROM drive. 

2. Open the .exe file. 

3. Click Next at the Welcome Screen. 

4. Read the License Agreement. Accept it and click Next. 

5. Accept the location of the program icons by clicking Next. If you wish to change the destination of the folder, 

click Browse. 

6. Follow the remaining steps. 

7. After installed, key in the Registration Key (16 digit) on the pop-up Registration screen and click Activate to 

online activate the key. 

Migrate Navicat Report Viewer to new computer 

All your connection settings are stored in registry. To view the registry record, in Windows, press WIN+R, then type 

"regedit". (The path should be "HKEY_CURRENT_USER/Software/PremiumSoft/ReportViewer".) 
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1. Backup your connection settings. 

2. In Navicat Report Viewer, choose Help -> Registration and click Deactivate to online deactivate the key. 

3. Uninstall Navicat Report Viewer from the existing computer. 

4. Re-install Navicat Report Viewer in the new computer. 

5. Restore your connection settings into registry. 

All your report files (.rtm) are stored within connections Report Location. To look for the path, right-click the connection 

and choose Edit Connection -> Advanced -> Report Location. 

Upgrade Navicat 

If you want to upgrade an installed copy of Navicat Report Viewer to the latest release, please choose Help -> Check 

For Updates to start the Updater. It will automatically check your installed version. If there is a new version, simply 

follow the steps in the Updater to upgrade your Navicat Report Viewer. It will replace your previous Navicat Report 

Viewer and your current settings will remain unchanged. 

Or, you can submit your registered email address on the Customer Center to download the latest version installer. 

End-User License Agreement  

Note: For the License Agreement of Navicat Cloud service, please click here. 

IMPORTANT: THIS SOFTWARE END USER LICENSE AGREEMENT ("EULA") IS A LEGAL AGREEMENT 

BETWEEN YOU (EITHER AN INDIVIDUAL OR, IF PURCHASED OR OTHERWISE ACQUIRED BY OR FOR AN 

ENTITY, AN ENTITY) AND PREMIUMSOFT CYBERTECH LTD..READ IT CAREFULLY BEFORE COMPLETING THE 

INSTALLATION PROCESS AND USING THE SOFTWARE. IT PROVIDES A LICENSE TO USE THE SOFTWARE 

AND CONTAINS WARRANTY INFORMATION AND LIABILITY DISCLAIMERS. BY INSTALLING AND USING THE 

SOFTWARE, YOU ARE CONFIRMING YOUR ACCEPTANCE OF THE SOFTWARE AND AGREEING TO BECOME 

BOUND BY THE TERMS OF THIS AGREEMENT. IF YOU DO NOT AGREE TO BE BOUND BY THESE TERMS, 

THEN DO NOT INSTALL THE SOFTWARE AND RETURN THE SOFTWARE TO YOUR PLACE OF PURCHASE. 

THIS EULA SHALL APPLY ONLY TO THE SOFTWARE SUPPLIED BY PREMIUMSOFT CYBERTECH LTD. 

HEREWITH REGARDLESS OF WHETHER OTHER SOFTWARE IS REFERRED TO OR DESCRIBED HEREIN.  

1. Definitions 

a. "Non-commercial Version" means a version of the Software, so identified, for use by i) the individual who is a 

natural person and not a corporation, company, partnership or association or other entity or organization (ii) the 

individual who is a student, faculty or staff member at an educational institution, and (iii) staff of a non-profit 

organization or charity organization only. For purposes of this definition, "educational institution" means a 

public or private school, college, university and other post secondary educational establishment. A non-profit 

https://customer.navicat.com/
http://legal.navicat.com/navicatcloud/NavicatCloudLicenseAgreement.rtf
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organization is an organization whose primary objective is to support an issue or matter of private interest or 

public concern for non-commercial purposes.  

b. "Not For Resale (NFR) Version" means a version, so identified, of the Software to be used to review and 

evaluate the Software, only.  

c. "PremiumSoft" means PREMIUMSOFT CYBERTECH LTD. and its licensors, if any.  

d. "Software" means only the PremiumSoft software program(s) and third party software programs, in each case, 

supplied by PremiumSoft herewith, and corresponding documentation, associated media, printed materials, 

and online or electronic documentation.  

e. "Unregistered version", "Trial version" or "Demo version" means an unregistered copy of the SOFTWARE 

("UNREGISTERED SOFTWARE") which may be used by the USER for evaluation purposes for a period of 

fourteen (14) days following the initial installation of the UNREGISTERED SOFTWARE. At the end of the trial 

period ("TRIAL PERIOD"), the USER must either register the SOFTWARE or remove it from his system. The 

UNREGISTERED SOFTWARE may be freely copied and distributed to other users for their evaluation.  

f. "Navicat Essentials" means a version of the Software, so identified, to be used for commercial purpose.  

2. License Grants 

The licenses granted in this Section 2 are subject to the terms and conditions set forth in this EULA:  

a. Subject to Section 2(b), you may install and use the Software on a single computer; OR install and store the 

Software on a storage device, such as a network server, used only to install the Software on your other 

computers over an internal network, provided you have a license for each separate computer on which the 

Software is installed and run. Except as otherwise provided in Section 2(b), a license for the Software may not 

be shared, installed or used concurrently on different computers.  

b. In addition to the single copy of the Software permitted in Section 2(a), the primary user of the computer on 

which the Software is installed may make a second copy of the Software and install it on either a portable 

computer or a computer located at his or her home for his or her exclusive use, provided that:  

A. the second copy of the Software on the portable or home computer (i) is not used at the same time as 

the copy of the Software on the primary computer and (ii) is used by the primary user solely as allowed 

for such version or edition (such as for educational use only),  

B. the second copy of the Software is not installed or used after the time such user is no longer the 

primary user of the primary computer on which the Software is installed.  

c. In the event the Software is distributed along with other PremiumSoft software products as part of a suite of 

products (collectively, the "Studio"), the license of the Studio is licensed as a single product and none of the 

products in the Studio, including the Software, may be separated for installation or use on more than one 

computer.  

d. You may make one copy of the Software in machine-readable form solely for backup purposes. You must 

reproduce on any such copy all copyright notices and any other proprietary legends on the original copy of the 

Software. You may not sell or transfer any copy of the Software made for backup purposes.  

e. You agree that PremiumSoft may audit your use of the Software for compliance with these terms at any time, 

upon reasonable notice. In the event that such audit reveals any use of the Software by you other than in full 

compliance with the terms of this Agreement, you shall reimburse PremiumSoft for all reasonable expenses 

related to such audit in addition to any other liabilities you may incur as a result of such non-compliance.  
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f. Your license rights under this EULA are non-exclusive.  

3. License Restrictions 

a. Other than as set forth in Section 2, you may not make or distribute copies of the Software, or electronically 

transfer the Software from one computer to another or over a network.  

b. You may not alter, merge, modify, adapt or translate the Software, or decompile, reverse engineer, 

disassemble, or otherwise reduce the Software to a human-perceivable form.  

c. Unless otherwise provided herein, you may not rent, lease, or sublicense the Software.  

d. Other than with respect to a Trial / Demo Version, Non-commercial Lite Version or a Not For Resale Version of 

the Software, you may permanently transfer all of your rights under this EULA only as part of a sale or transfer, 

provided you retain no copies, you transfer all of the Software (including all component parts, the media and 

printed materials, any upgrades, this EULA, the serial numbers, and, if applicable, all other software products 

provided together with the Software), and the recipient agrees to the terms of this EULA. If the Software is an 

upgrade, any transfer must include all prior versions of the Software from which you are upgrading. If the copy 

of the Software is licensed as part of the whole Studio (as defined above), the Software shall be transferred 

only with and as part of the sale or transfer of the whole Studio, and not separately. You may retain no copies 

of the Software. You may not sell or transfer any Trial / Demo Version, Non-commercial Lite Version or Not For 

Resale Version of the Software.  

e. Unless otherwise provided herein, you may not modify the Software or create derivative works based upon the 

Software.  

f. Non-commercial Versions of the Software may not be used for, or distributed to any party for, any commercial 

purpose.  

g. Unless otherwise provided herein, you shall not  

A. in the aggregate, install or use more than one copy of the Trial / Demo Version and Non-commercial 

Lite Version of the Software,  

B. download the Trial / Demo Version and Non-commercial Lite Version of the Software under more than 

one username,  

C. alter the contents of a hard drive or computer system to enable the use of the Trial / Demo Version of 

the Software for an aggregate period in excess of the trial period for one license to such Trial / Demo 

Version,  

D. disclose the results of software performance benchmarks obtained using the Trial / Demo Version or 

Non-commercial Lite Version to any third party without PremiumSoft prior written consent, or  

E. use the Trial / Demo Version of the Software for a purpose other than the sole purpose of determining 

whether to purchase a license to a commercial or education version of the software; provided, however, 

notwithstanding the foregoing, you are strictly prohibited from installing or using the Trial / Demo 

Version or Non-commercial Lite Version of the Software for any commercial training purpose.  

h. You may only use the Not for Resale Version of the Software to review and evaluate the Software.  

i. You may receive the Software in more than one medium but you shall only install or use one medium. 

Regardless of the number of media you receive, you may use only the medium that is appropriate for the 

server or computer on which the Software is to be installed.  

j. You may receive the Software in more than one platform but you shall only install or use one platform.  

k. You shall not use the Software to develop any application having the same primary function as the Software.  
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l. In the event that you fail to comply with this EULA, PremiumSoft may terminate the license and you must 

destroy all copies of the Software (with all other rights of both parties and all other provisions of this EULA 

surviving any such termination).  

m. This program may include Oracle Instant Client (OCI). You agree that you shall  

1. not use of the Oracle Instant Client to the business operations;  

2. not assign, give, or transfer the Oracle Instant Client or an interest in them to another individual or 

entity;  

a. make the Programs available in any manner to any third party for use in the third party's 

business operations; and  

b. title to the Programs from passing to the end user or any other party;  

3. not reverse engineer, disassemble or decompilation the Oracle Instant Client and duplicate the 

Programs except for a sufficient number of copies of each Program for your licensed use and one copy 

of each Program media;  

4. discontinue use and destroy or return to all copies of the Oracle Instant Client and documentation after 

termination of the Agreement;  

5. not pubish any results of benchmark tests run on the Programs;  

6. comply fully with all relevant export laws and regulations of the United States and other applicable 

export and import laws to assure that neither the Oracle Instant Client, nor any direct product thereof, 

are exported, directly or indirectly, in violation of applicable laws;  

7. allow PremiumSoft to audit your use of the Oracle Instant Client;  

4. Upgrades 

If this copy of the Software is an upgrade from an earlier version of the Software, it is provided to you on a license 

exchange basis. You agree by your installation and use of such copy of the Software to voluntarily terminate your 

earlier EULA and that you will not continue to use the earlier version of the Software or transfer it to another person or 

entity unless such transfer is pursuant to Section 3.  

5. Ownership 

The foregoing license gives you limited license to use the Software. PremiumSoft and its suppliers retain all rights, title 

and interest, including all copyright and intellectual property rights, in and to, the Software (as an independent work and 

as an underlying work serving as a basis for any application you may develop), and all copies thereof. All rights not 

specifically granted in this EULA, including Federal and International Copyrights, are reserved by PremiumSoft and its 

suppliers.  

6. LIMITED WARRANTY AND DISCLAIMER 

a. Except with respect to Trial / Demo Version, Non-commercial Lite Version and Not For Resale Version of the 

Software, PremiumSoft warrants that, for a period of thirty (30) days from the date of delivery (as evidenced by 

a copy of your receipt): the physical media on which the Software is furnished will be free from defects in 

materials and workmanship under normal use. The Software is provided "as is". PremiumSoft makes no 

warranties, express or implied, arising from course of dealing or usage of trade, or statutory, as to any matter 

whatsoever.  
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b. PremiumSoft provides no remedies or warranties, whether express or implied, for Trial / Demo version, 

Non-commercial Lite version and the Not for Resale version of the Software. Trial / Demo version, 

Non-commercial Lite version and the Not for Resale version of the Software are provided "as is".  

c. Except as set Forth in the foregoing limited warranty with respect to software other than Trial/ Demo version, 

Non-commercial Lite version and Not for Resale version, PremiumSoft and its suppliers disclaim all other 

warranties and representations, whether express, implied, or otherwise, including the warranties of 

merchantability or fitness for a particular purpose. Also, there is no warranty of non-infringement and title or 

quiet enjoyment. PremiumSoft does not warrant that the Software is error-free or will operate without 

interruption. The Software is not designed, intended or licensed for use in hazardous environments requiring 

fail-safe controls, including without limitation, the design, construction, maintenance or operation of nuclear 

facilities, aircraft navigation or communication systems, air traffic control, and life support or weapons systems. 

PremiumSoft specifically disclaims any express or implied warranty of fitness for such purposes.  

d. If applicable law requires any warranties with respect to the Software, all such warranties are limited in duration 

to thirty (30) days from the date of delivery.  

e. No oral or written information or advice given by PremiumSoft, its dealers, distributors, agents or employees 

shall create a warranty or in any way increase the scope of ANY warranty PROVIDED HEREIN.  

7. LIMITATION OF LIABILITY 

(a) Neither PremiumSoft nor its suppliers shall be liable to you or any third party for any indirect, special, incidental, 

punitive or consequential damages (including, but not limited to, damages for the inability to use equipment or access 

data, loss of business, loss of profits, business interruption or the like), arising out of the use of, or inability to use, the 

Software and based on any theory of liability including breach of contract, breach of warranty, 

tort (including negligence), product liability or otherwise, even if PremiumSoft or its representatives have been advised 

of the possibility of such damages.  

8. Third Party Software 

The Software may contain third party software which requires notices and/or additional terms and conditions. By 

accepting this EULA, you are also accepting the additional terms and conditions of the third party software.  

9. General 

No PremiumSoft dealer, agent or employee is authorized to make any amendment to this EULA.  

This EULA contains the complete agreement between the parties with respect to the subject matter hereof, and 

supersedes all prior or contemporaneous agreements or understandings, whether oral or written. You agree that any 

varying or additional terms contained in any purchase order or other written notification or document issued by you in 

relation to the Software licensed hereunder shall be of no effect. The failure or delay of PremiumSoft to exercise any of 

its rights under this EULA or upon any breach of this EULA shall not be deemed a waiver of those rights or of the 

breach. 
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If any provision of this EULA shall be held by a court of competent jurisdiction to be contrary to law, that provision will 

be enforced to the maximum extent permissible, and the remaining provisions of this EULA will remain in full force and 

effect.  

10. Basis of Bargain 

The Limited Warranty and Disclaimer and Limited Liability set forth above are fundamental elements of the basis of the 

agreement between PremiumSoft and you. PremiumSoft would not be able to provide the Software on an economic 

basis without such limitations. Such Limited Warranty and Disclaimer and Limited Liability inure to the benefit of 

PremiumSoft's licensors.  

11. Term 

By downloading and/or installing this SOFTWARE, the Licensor agrees to the terms of this EULA. 

This license is effective until terminated. Licensor has the right to terminate your License immediately if you fail to 

comply with any term of this License.  

"as is". Licensor makes no warranties, express or implied, arising from course of dealing or usage of trade, or statutory, 

as to any matter whatsoever. In particular, any and all warranties or merchantability, fitness for a particular purpose or 

non-infringement of third party rights are expressly excluded. 

12. Governing Law 

This License will be governed by the laws in force in Hong Kong. You hereby consent to the non-exclusive jurisdiction 

and venue sitting in Hong Kong to resolve any disputes arising under this EULA. 

Should you have any questions concerning the validity of this License, please contact: licensing@navicat.com. If you 

desire to contact the Licensor for any other reason, please contact support@navicat.com. 

PremiumSoft and other trademarks contained in the Software are trademarks or registered trademarks of PremiumSoft 

CyberTech Ltd. in the United States and/or other countries. Third party trademarks, trade names, product names and 

logos may be the trademarks or registered trademarks of their respective owners. You may not remove or alter any 

trademark, trade names, product names, logo, copyright or other proprietary notices, legends, symbols or labels in the 

Software. This EULA does not authorize you to use PremiumSoft or its licensors names or any of their respective 

trademarks. 
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Chapter 2 - User Interface 

Main Window 

The Main Window consists of toolbars and panes for you to work on connections and reports. 

 

 Main Toolbar 

The Main Toolbar allows you to create connections and access basic features, such as print, search, etc. Click the 

Refresh button to achieve the most up-to-date data from the server. 

 Navigation Pane 

The Navigation pane is the basic way to navigate with connections and reports. It employs tree structure which allows 

you to take action upon the connection and reports through their pop-up menus quickly and easily. 

 Tabs Bar 

The Tab Bar allows you to switch among the opened reports. If you have multiple tabs open, you can use CTRL+TAB 

to easily switch to other tabs. 

 Report Pane 

The Report pane displays the .raf and .rtm reports. 

 Bottom Toolbar 

The Bottom Toolbar provides other controls that you can use to view the report. 

Hint:  - Zoom In; ALT+  - Zoom Out. 
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 Status Bar 

The Status Bar displays the current window's status information. 
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Chapter 3 - Connection 

About Connection 

To start viewing reports in Navicat Report Viewer, you should first establish a connection or several connections using 

the Connection window. If you are new to the server or 'Net in general' and are not quite sure how things work, you may 

want to look at: 

 MySQL User Manual 

 Oracle Database Documentation 

 PostgreSQL User Manual 

 SQLite User Manual 

 SQL Server MSDN Library 

 MariaDB Documentation 

To create a new connection, click  Connection and select your server type. Then, enter the necessary information 

in the Connection window. 

After the connection being established, you need to place your report files (.rtm) to the Report Location before viewing 

and printing your reports. 

Note: Navicat Report Viewer authorizes you to make connection to remote servers running on different platforms, i.e. 

Windows, macOS, Linux and UNIX. 

General Settings 

To successfully establish a new connection to local/remote server - no matter via SSL, SSH or HTTP, set the database 

login information in the General tab. If your Internet Service Provider (ISP) does not provide direct access to its server, 

Secure Tunneling Protocol (SSH) / HTTP is another solution. 

Note: The following options depend on the connection server type and sort in ascending order. 

Authentication 

SQL Server Authentication Use login records to validate the connection. Users must provide their server 

login: User Name and Password. 

Windows Authentication When a user connects through a Windows user account, SQL Server validates 

the account name and password using the Windows principal token in the 

operating system. 

 

http://dev.mysql.com/doc/
http://www.oracle.com/technology/documentation/index.html
http://www.postgresql.org/docs/manuals/
http://www.sqlite.org/docs.html
http://msdn.microsoft.com/en-us/library/bb545450(v=SQL.10).aspx
https://mariadb.com/kb/en/mariadb-documentation/
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Connection Name 

Enter a friendly name to best describe your connection. 

Connection Type 

Basic In Basic mode, it connects to Oracle through the Oracle Call Interface (OCI). Enter the 

Host Name/IP Address and Port. Set the Service Name/SID which the user connects 

when making connection. Select the corresponding radio button. 

TNS In TNS mode, it connects to Oracle server using an alias entry from a tnsnames.ora file 

through the Oracle Call Interface (OCI). User needs to provide the Net Service Name. 

OCI is an application programming interface that allows an application developer to use a third-generation language's 

native procedure or function calls to access the Oracle database server and control all phases of SQL statement 

execution. OCI is a library of standard database access and retrieval functions in the form of a dynamic-link library. See 

also: OCI options 

Database File 

Specify the initial database file. If the HTTP Tunnel is enabled, you need to enter an absolute file path of the database 

file in your web server. 

Host Name/IP Address 

A host name where the database is situated or the IP address of the server. 

Initial Database 

Set the initial database which user connects when making connection. 

Password 

Password for connecting to the database server. 

Port 

A TCP/IP port for connecting to the database server. 

User Name 

User name for connecting to the database server. 

SSL Settings 

Secure Sockets Layer(SSL) is a protocol for transmitting private documents via the Internet. To get a secure 

connection, the first thing you need to do is to install OpenSSL Library and download Database Source. 

Note: Available only for MySQL, PostgreSQL and MariaDB. Support from PostgreSQL 8.4 or later. 
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MySQL and MariaDB Connections 

To provide authentication details, enable Use Authentication and fill in the required information: 

Client Key 

The SSL key file in PEM format to use for establishing a secure connection. 

Client Certificate 

The SSL certificate file in PEM format to use for establishing a secure connection. 

CA Certificate 

The path to a file in PEM format that contains a list of trusted SSL certificate authorities. 

Verify CA Certificate Name 

Check the server's Common Name value in the certificate that the server sends to the client. 

Specified Cipher 

A list of permissible ciphers to use for SSL encryption. 

PostgreSQL Connection 

Choose the SSL Mode: 

require Only try an SSL connection. 

verify-ca Only try an SSL connection, and verify that the server certificate is issued by a trusted 

CA. 

verify-full Only try an SSL connection, verify that the server certificate is issued by a trusted CA 

and that the server hostname matches that in the certificate. 

To provide authentication details, enable Use Authentication and fill in the required information: 

Client Key 

The path of the client private key. 

Client Certificate 

The path of the client certificate. 

CA Certificate 

The path of the trusted certificate authorities. 

Certificate Revocation List 
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The file path of the SSL certificate revocation list (CRL). 

SSH Settings 

Secure SHell (SSH) is a program to log in into another computer over a network, execute commands on a remote 

server, and move files from one machine to another. It provides strong authentication and secure encrypted 

communications between two hosts, known as SSH Port Forwarding (Tunneling), over an insecure network. 

Typically, it is employed as an encrypted version of Telnet. 

In a Telnet session, all communications, including username and password, are transmitted in plain-text, allowing 

anyone to listen-in on your session and steal passwords and other information. Such sessions are also susceptible to 

session hijacking, where a malicious user takes over your session once you have authenticated. SSH serves to prevent 

such vulnerabilities and allows you to access a remote server's shell without compromising security. 

Note: Available only for MySQL, Oracle, PostgreSQL, SQL Server and MariaDB. 

Please make sure that the parameter - "AllowTcpForwarding" in the Linux server must be set to value "yes", otherwise, 

the SSH port forwarding will be disabled. To look for the path: /etc/ssh/sshd_config. By default, the SSH port forwarding 

should be enabled. Please double check the value settings. 

Even the server support SSH tunnel, however, if the port forwarding being disabled, Navicat Report Viewer cannot 

connect via SSH Port 22. 

Host Name/IP Address 

A host where SSH server is activated. 

Note: The host name in the General tab should be set relatively to the SSH server which provided by your database 

hosting company. 

Port 

A port where SSH server is activated, by default it is 22. 

User Name 

A user on SSH server machine. (It is not a user of database server.) 

Authentication Method 

Password Provide the SSH server user Password. 

Public Key Private Key 

It is used together with your public key. The private key should be readable only by you. 

Passphrase 

A passphrase is exactly like a password, except that it applies to the keys you are 

generating and not an account. 
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Note: HTTP Tunnel and SSH Tunnel cannot be function simultaneously. The SSH Tunnel is disabled when you select 

the HTTP Tunnel and vice versa. 

HTTP Settings 

HTTP Tunneling is a method for connecting to a server that uses the same protocol (http://) and the same port (port 80) 

as a web server does. It is used while your ISPs do not allow direct connections, but allows establishing HTTP 

connections. 

Note: Available only for MySQL, PostgreSQL, SQLite and MariaDB. 

Uploading the Tunneling Script 

To use this connection method, first thing you need to do is to upload the tunneling script to the web server where your 

server is located. 

Note: ntunnel_mysql.php (for both MySQL and MariaDB), ntunnel_pgsql.php or ntunnel_sqlite.php is available in 

the Navicat Report Viewer installation folder. 

Setting up HTTP Tunnel 

The following instruction guides you through the process of configuring a HTTP connection. 

1. Select the HTTP tab and enable Use HTTP Tunnel. 

2. Enter URL of the tunneling script 

e.g. http://www.navicat.com/ntunnel_mysql.php 

3. If your server installed a Web Application Firewall, you can check the Encode outgoing query with base64 

option. 

4. If the tunneling script is hosted in a password protected server or you have to access internet over a proxy 

server, you can provide the required authentication details in Authentication or Proxy tab. 

Note: HTTP Tunnel and SSH Tunnel cannot be function simultaneously. The SSH Tunnel is disabled when you select 

the HTTP Tunnel and vice versa. 

Advanced Settings 

Note: The following options depend on the connection server type and sort in ascending order. 

Attached Databases 

Click Attach Database to attach a database to the connection. Choose the Database File path of the database and 

enter the Database Name. If the database file is encrypted, check the Encrypted option and provide the Password. 

Select a attached database from the list and click Detach Database to detach it. 
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Auto Connect 

Open the connection at application startup automatically. 

Encoding 

Choose a codepage to communicate with MySQL Server while MySQL character set not being employed. 

Encrypted 

Enable this option and provide Password when connecting to an encrypted SQLite database. 

Keepalive Interval (sec) 

Keep the connection with the server alive by pinging it. You can set the period between pings in the edit box. 

OS Authentication 

Use OS user login credentials to authenticate database users. 

Report Location 

Choose the file path of your report files. You are allowed to change any locations as you like. 

Role 

Indicate that the database user is connecting with either the Default, SYSOPER or SYSDBA system privilege. 

Use Compression 

Use compression protocol. It is used if both client and server support zlib compression, and the client requests 

compression. 

Use Encryption 

Use encryption for SQL Server connection. 

Use Named Pipe, Socket 

Use socket file for localhost connection. 
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Chapter 4 - Report Handling 

Open Report with Server Connection 

After created a connection and placed report files in Report Location, you can open the reports. 

1. Open a connection in the Navigation pane. 

2. Double-click the report to open. 

Open Report with Search Parameter 

If you have been provided with a search report, you are allowed to enter the parameter(s) to limit your search results 

that meet your criteria. In order words, you can determine the results of your report output. 

Just simple click  Search from the toolbar and enter your search value(s). 

 

Open Archived Report 

There is not necessary to establish server connection to view your reports if you are provided with archive files (.raf). 

However, please bear in mind that all data stores in the archive files will not contain the most up-to-date data. 

Just simple select File ->  Open Report from the menu bar and browse the archive file. 

 

https://community.navicat.com/videos?view=navicat&category=9
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Print Report 

You can print a report to a printer, simply click the  Print button from the toolbar. 

Print Report to File 

Navicat Report Viewer not only allows you to print your reports to printer but also many kind of file formats, i.e. PDF, 

HTML, Excel and more. 

Print Report using Pop-up Menu 

Right-click a report in the Navigation pane and choose Print Report As -> PDF/HTML/Excel/Archive. 

 

Print Reports to Other File Formats 

The Print to File under the Print dialog will be available if the user, who created the reports, enabled AllowPrintToFile 

option in Navicat's Report Building Tool. 

1. Right-click a report in the Navigation pane and choose Print Report or just simply click the  Print button 

from the toolbar. 

2. Choose the file type and location in the Print dialog. 

 

  

https://community.navicat.com/videos?view=navicat&category=9
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Chapter 5 - Other Advanced Tools 

Virtual Grouping 

Virtual Group aims to provide a platform for logical grouping objects by categories, so that all objects are effectively 

preserved. It can be applied on connections and reports. 

If you want to hide the group structure, select View -> Flatten Connection from the menu bar. 

Create a new group 

1. In the main window, right-click on the Navigation pane or a report and select Manage Group -> New Group. 

2. Enter a name for the new group. 

Move a connection/report to a group 

1. In the main window, right-click a connection/report and select Manage Group -> Move To. 

2. Select an existing group. 

Move a connection/report back to the top-level 

1. In the main window, right-click a connection/report and select Manage Group -> Exclude From Group. 

Hint: You can also use the drag and drop method to move connections or reports. 

Search Filter 

Navicat Report Viewer provides search filters for searching connections and reports in the Navigation pane. 

In the Navigation pane, click on the pane to focus and enter a search string directly. If connections have opened, the 

filter will also apply to their reports. 

You can remove the filter by deleting the search string. 
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Chapter 6 - Configurations 

Options Settings 

To set additional settings, select Tools -> Options from the menu bar. 

Miscellaneous 

Files Location 

The file records how connections and reports are categorized stores in the profiles directory and all the log files store 

in the logs directory. 

Activation & Updater 

Check for updates on startup 

Check this option to allow Navicat Report Viewer checks for new version when it starts. 

Proxy 

Use Proxy 

Check this option to use proxy for the activation process. Choose the Proxy Type and enter Host, Port, User Name 

and Password. 

OCI 

Hint: Restart Navicat Report Viewer to take effect. 

OCI library (oci.dll) 

Choose the Oracle Client / Oracle Instant Client folder that includes the OCI library (oci.dll) for Basic/TNS connection. 

It has already included in Navicat Report Viewer installation folder. You can locate it directly. 

Oracle Instant Client is the simplest way to deploy a full Oracle Client application built with OCI, OCCI, JDBC-OCI, or 

ODBC drivers. It provides the necessary Oracle Client libraries in a small set of files. You can also download Oracle 

Client / Oracle Instant Client through - 

Oracle Client 

Oracle Instant Client 

Download the appropriate Instant Client packages for your platform and the CPU. All installations REQUIRE the Basic 

or Basic Lite package. Unzip the packages and set the path points to it. 

  

http://www.oracle.com/technetwork/database/enterprise-edition/downloads/index.html
http://www.oracle.com/technetwork/database/features/instant-client/index-097480.html
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Chapter 7 - Trace Logs 

Log Files 

Navicat Report Viewer provides log files to keep track on the actions have been performed in Navicat Report Viewer 

and they are located in the logs directory, e.g. C:\Users\Guest\Documents\Navicat Report Viewer\logs\. You are 

allowed to change the log files location under Options. 

HttpDump.log 

Store information which response from your HTTP Server. 

LogHistory.txt 

Store all SQL statements of all the operations executed over databases and database objects in Navicat Report 

Viewer. 

Note: This log will be overwritten while Navicat Report Viewer is being restarted. 
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